2=)le (sl plasliwl
elaialsal s 5 2)lis ©
S L 0 35 8 5 b jga T 3 ol

Y-EY/YEN/E a3 laslid o5

T o S
3 R e die U5 Al b ) gl 9o lis 3 a0l
Ll e b 1D/ /) 3 il A5




www.PDFgozar.com

PowerPoint 2007 Sl &1

:Q)Le‘.o é)‘d.’buv)'

FoEYIYEIF 1 3 ailinel o ylo (59 (gl 48 y> 5 36 bignl csbosbw) g,I81 1580 o 0,18

VAN 13 ylilbowl Loy (soSluol 8Lyl g Kb 8 & 59) (55 Londio 15 &Ly,

[0 sleelss ] PowerPoint 2007 CJlas «51,| ousyglagay ob g ¢ylgse
WSsn 9 sl Oilis [ln Josls el muyo ) I3355 105 cedlge
(s2y9el S0y el g g Glojl

VAN s i ol ol 1yl Olaseio
Js»\> ‘gs'i.’) ygan (@ \YA :‘_;on’uLa:'ui,.o
AFf--0-1VYYa-) Sols

Led iomigd Cowpd Candy

4l 054 :eawlosl

(aawgie) oijgel slosal, - iseals Egogo

YYOYF ¢« moyo e ool el AYOY iy )15 )4 100938 awll
(s2ygel 30y el g g Glosle 1009381 Awlidy

1YAA



www.PDFgozar.com

113 Oligel W18 g p e oy o

o, G 1ol pd (Sl 4 LS (pl Glgixe (5 0 b0 1) 095 Wil g Wlolesuday
b g G189 gl 48y 9 (S8 b g0l U g (30 %l 1585 FAVEND (5 oleds
o lod Jluyl 395 (Sig il Gy

www.tvoccd.sch.ir: g sl w,sT info@tvoced.schuir : Kuig S oy

0095 9 wigel Wylie

23l Gy aelp g Glagh (lejle
Sl 8 g (1 4850 g (S8 sl 390l i g (5315 4ol 8O g gl g il s
PowerPoint 2007 il &l : 5 ,keo olS b
ool el s po ¢ )05 59 1505 1yl g0
Jowy e (Al Ly y8 (3, Lo oo (ol jllas Jos tlgiixo 0uidS oy 09,5 slas!
(o) yorzr ol — 89 dougd — 003 Chwgy (g yiowd) (195 (oo 390] 09,5 1ylewl g
1%y
WS S 2598 9 ol U5 oylol il >
Jol Cug — 1WA LSl Sl g Cogs
o Sy it ol : il
Fasly FF SN ol 495 « Il (659 s (Il el 5 130T
AAVEYYYY :yals

Olesle G5 5 sl ad > g 23 slo (ijeel Gl 5 (5, asliyy ;180 3 jlaw a4y (oDl oLli )l
o s b g (Bisel 05)S Lawsi (hyem o tisel Slis chieel iy aslin 5 Limeh
.w‘ ad.r.w) uL?- dJ);;Mrﬁb J..ubs ww

#Cawl oo Ol 3%
ISBN:964-05-1729-1 AFF—+O-1VYA-) iSOLs




www.PDFgozar.com

A 9 0S50 (1500 Gl 1) 995 Cowd i piy @alie Wlaluial 4o a5 plole auiluy
A g BeSl Lol jo wilel sl 50 Cd piay 9 5001 W yad (il jaSo 1y o Fi90 50
(G gl 0 g (003)) o> ool & >




www.PDFgozar.com



www.PDFgozar.com

bl s

el 39133 o & 9l G5 wua 9 JolSS 5035 sl JloS 5 Loy 5353 50 lunl
Olele ax 58 5 Juga 5o ) 1S Seuw & Yl ple bl Jbe o) ple 6 pidoe Sl aedle juss &
Do o plin SIS SIS S 4 Gl 33,5 vy 4l
A Ao 95 (3 VB o el Abls Jodue Sisel Liils 5 s h9l ple & 2l 5 95« Ml 90 ol Jl
.J.iibu.ou.y}';)ﬁdﬂlﬁb";lC)_\ﬂoé)fLs)}onlc
Il ple Somw &5 Sl azu)s DS el DS T o e a5l Gl Zlixe el ple 5 ple Lol
2 Gl 03 dcgezme puis 5 Dl A plaBl aVled a5 cwl oaib T jo s Ghigel 09,5 9 ol
oMl SLis)l 5 it 38 w)lis Mlssbusl 5 ) oS (sl a8 9 S8 GhIgel Yleilw 3olastusl 4l o sl
oles
ol manl 5ol (6 ad) Ylwlub)lS Jl rea B 5 (2w Juols dls o) Gl US> &S ¢l Acgoxo
A (sl aisF QO cunl 03l Al S3eiS Sbisel BLalS & s 55 63 ,%9) wldie la Ada Jl dcgeze
aub) ol opelee i)l Sla 4 =5 5w )0 Slabsy 03 by whuss skl vode wuwl Aii.mj'}'i
Oligel Lisls =¥ie Guin Jl LeliS opl ol « Siiwd wlze Kod S ol ralge &5 T JlaiS Jloclly
SIS s )3 ) oo S iy BB & s 5 wuelib T IS ol geT Lisls sla Slss b o . ol
weanl 438 )5 s T udd oo 5 a8 9 (LIS I dAcgaze cpl w38
sl 3) S8 e SIS 3l ol &F sl i (g5 09,5

S 5o Obl & ShJseT So0 K &5 Hla G 03 S)lsliusl S wacls S3dk eawis ©

sl 03 (52933 Ul geT Ll 39,9 wiledbl yirian ) sbaio 43 3)lasluwl & slawl V> He)T i ©

wmanl 03ub Ol Sl dodiie Sbisel callae b jsel Ll (383 (6 )5 Sl Juad jo slawl )y @

ol 9005 e 9 P 4 plF 03l e gaze cpl ) gl J9) @

sl 0 (2995 Q9T 359 508 JSb Jl Olisebl s 00> 1 Lo (205 @
Al 5o pu2S BILS) Blaal ples Jolid 5 gels lloe aoda

S8 500003 ) oS )d 0 C)Jo.n oSl ils) [olo.'i} I3 39n9 Juad o slal )3 aslicjly ®
3T 9 (7 pis) (FBL) (sl &35 0lUa) (53350 9n) (dale 5 o) JSib iy VS 5 45 V9o )T
il 08U 132933 Slwa=s  Hlub i)l sla WSS u-’);T L Gl Sloc

s ghiRy Ol 33— a9 S gel 09,8



www.PDFgozar.com

o pzs a ansi b g d5b @8ly duie ublie sl Jilgiy DUS pl &Sl 4 Sael 5 VE 3 9 5 Il puliw b
Power Point 2007 _us los 5 @b OT mcobiseT ils SbJ)seT la SliS Hu s )s aubis
2508 13 S e 5 el il & B 035 mid JoB las a5 5 Lo Jlie Sl oslaiwl L )
O8I = 03 9 3kl (50 L)l =)y 9 sl a8 ) Sid uﬁa)’,.oT sl Solastowl Gulsl o DS ¢yl oo
OIS by 5531y Basiiss 5 bJsel sl ange &F S)IS 3535 3L HNlen b 5 IS
39 5o gl

b sla V181 e x5 ()5 598 Il 5% 5 wxdling )Sae S b &y 3laie POwer Point 2007 151 e s
bl (5o (255329 9 5 225005 ¢ Siguo e a3l sl iules sl Jolb 5 3Nl

L L) wlxiio 3ilgs o inh) 4 loib 9 0353 ol T b D133l e )5 ol Jl oslaiwl b b Ginles 3l b
- 3wbles skl 0325 sl ogla

Felb oo V)09 1 0)



=

o YR Powerpoint 2007 1331 o s Joaxoly (LubT 1\
) ettt — e e et ———————————————————————————————————————————— Office s anss 1-1-\
B e (Quick ACCESS ) & pus (w0 piawd Jlgs \-1-¥
R SR (Ribbon) ysu, V-1-¥
Y ettt ettt —————————————————————————————————————— (slide ) asMwl V-\-€
A (Slide/Outline) soMuwl okl s anl V\-1-d
ettt e s e e e e (Status bar) wusss Jlss \-\-#
L P TP PO PP PP PPPPP ( Note Page ) cuilssb o y=is V-1-Y
| LN B3 iules G Szl \-Y
1 N hles Aol jo S5 95 0 udd \-Y
N e ———————— 39390 (Shles doli jo 95 L \-E
|1 RN (Layout) ssMuwl glosus -0
| YR Al Z)3 -1-F SIS plosuy 1-0-)
LTS T TSP wlgizxe )3 6l plodsy 1-d-Y
LY ettt rrreerrreeeeerreaaeereeaseerenaseerennssaerrnnnstrrrnnsarrrnnsanerenn Ml Zy3 V-7
N e e e e e e e nnnna e e e e e eeenmnnnnaaanrrann oMl B3a V-V
YA e ————— AMwlys(Theme ) 7 b < Jlosly Alpb Y-\
B e ettt Sl oS 43 3y dige g Jleel Y-1-)
T Ml i oS Y-Y
| OFe s B9 cluoguod juuss Y-V
118 U STTPPSTTOTTPTROT 98 wluo giad puss P-¥-)
L8 KOOSO TOTRRRO STLL eubais Y-Y-¥
B e ———————————— Oles wilise Sl b (U T Y-¢
B ettt ettt (Normal) Jsoze sles ¥-£€-1

Lo/ YT RTT (Slide Sorter) a,Mwl (s3is aws slos Y-E-¥




| TSR (Notes page) wuslssb sles P-£-¥
TD ettt (Slide show) suMwl inles sles Y-£-€

PSS G905 Jalb K zos ¥-¥-)

D e Clip Art jy5b05 z)s Y-Y-¥

1) 03uh )3 pagaas inlyg Y-E
oY Shapes osleT Jsibl Y-
D) et e e e e e e e e e e e ——eaaaeeeaee———eeaaaaaaaaans Shape z,» ¥-b-\

oY YT TRR R oauib zos Shape juss Y-0-v

Y Word Art s i oy zos Y-7
) (Text Box) ¢yio dusn z)s Y-V
DA s ouSe pgalT il Y-A
Fn e ————— (Heyperlink) asgs z,)5 ¥-9
Y i —————— (Smart Art) Lilojw s Hloges s Y-\
YY e ( Slide Master ) suMuwl 5931 slos yimms 9 Slxsl Jguol by (UuidT E-
1T/ o Slide Master 5 wlbgizo )3 (59, 9 puss E-Y
L' Slide Master ,s axauoly 9 3wl o loshs ¢ F )6 S E-Y
2 2 229003 9 S5 JUobl ) E-E

) S (Slide Transition)asMwl )35 b UubT d-\
A& e, Sl 4 JIAS 53,8 Jleel 8-1-)



............................................................................................ oMl I IAS Ldids O-1-Y
A ettt ae e e enes (& oMl ¢y S pn o9z O-\-Y
AV e e e Ml AT A lass @ 45 aslsl d-1-¢
A s (Transition Speed) auMuwl JI3S shal cac jw d-1-0
L T Action Button illoc sl 4e5's 3 )5 Jguol (bwlivis d-Y
1 Y 3wl ) clubol ¢piinnossl b T O-Y
QD) ettt ettt ettt ettt e et te et reene e teeaeeneereeneeenas Ml 5 )3 el @ulsis Jguol O-Y-)

L 2 o LB ZHs 7-\
N e (Sound From File) g0 Jobb zos #-1-)
Vo Qe (Sound From Clip Organizer) s sla wuls zos #-1-Y
1) ) R 3922 6339 S ogla Jlocl (plwlinhs 7-Y
L} 1 2SS P29 s hL 7S Jgeol 7-Y

..................................................................... 29 B s ) Jguol 7-E

...................................................................... Slide Show Jgsol (»lwlish Y-
1) & (From Beginning) saMuwl ¢yudsl 5l oMl yiules g9 b Y-Y
|| {0 Y (From Current Slide) )by 3aMuwl jI La3sMwl yiules g9 b V-Y
WYY Custom Slide Show i law yisles Y-E
|} S (Setup Slide Show) iules g95 ¢yuss 9 leadis Y-
1 PSR SURRR (Show Type) iules g3 ozl V-0-1
[ ( Hide Slide) soMuwl u3,5 oligy Y-d-Y
T ( Record Narration)sssluwl 5, » (S5so wlxusdss s V-0-Y
VY e (Rehearse Timings) sl o inles ashl ol wsad V-0-€
\¥A.....(Use Rehearsed) Timings Slide Show (sles ) cauts el (s3is plo ) Jl oslaiwl Y-0-0
[} o ( Resolution) y3g.05 waaias V-7

..................................... (Show Presentation On) asi)l )&uules wlxisl Y-Y



N Use Presenter View aiy 35 Y-A

VEA (Spelling) ygio Mol FTazas (55 3a9 A-\
LT LN Comment wilxusgs A-Y
\d-

s 3 T A-Y-\

{14 L Package uiules (Jold (g3ds dimns A-D




=t

AL b5 o)l S)lasUuwl
Y-/EV/YEN//Y : 3 )15kl o )louks

(1sclaial ygol 915 Ciylj9) 14 jgnl 3)12iliml

wleMbl 6)3Toé ab r:.-.QsLmo
Sledio Jwole P
wlbls)l 5 wlelbl

38 gy Jale s

SISIHBL 055 )b )Hlo Sl as il
Y—/EV/YE/N/E : 3135wl o ylosks

Word 2007 jls ; oJjls

PowerPoint 2007 —JUo. 431l

Excel 2007 o yiuS a=bo

SleSs 51l slajl 8l o s




(1508wl 3Ly 1 9 LSimpo C3)ljg) (i1 jgnl 3)12iliml

oo YIS ALy : o)l S 15Ul
=B «d = 10/1/1: 3 133Gl o ylosks

wleMbl 6)}TQ9 o
Siledio Jole Pl
wlbls)l 5 wleMbl
Word 2007 Jls » ojls

PowerPoint 2007 —JUos i)l
Excel 2007 o5 s axao
Access 2007  sleMbl L

A yul YU ALl 1 o )Hlo Sl Uil
=B 8 —10/1/Y: 3135wl o plosis

SleSs 51l slajl 8l o s

Sleddn (s gs 4ol o




Tably 50 225 Lol e 3l S elas's j» PowerPoint 2007 1331 o 55-1

6 8 (<l

o (o

i (Z

woleT (o

3,85 50018 Startass's sla asl yjl 09,5 plas s s jl pwPowerPoint 2007 asb o-¥
System tools (-l

All program (—

Accessories (z

Entertainment (s

oo 4ol o s Sl ax a3 jsaiys Startup wewd)ys ) PowerPoint aol y a5 5590005 -¥
Tausl

S 5ebyd Ol el )3 awl y (all

D35 e Jatie ) )lss a3 aeb po T (o

S8 5001,8 Office button sl 8 wawud)s (7

Soib 5o Al D58 g0 & Sl a4 g9 b IR aeli 2 (5

T35ub 5o o3laiwl 4y 357 plasTl PowerPoint o =i o jlasl gasle) iSlaa & sl -£
Restore (sl

Maximize (—

Close (z

Minimize (s







Shec

(318) 65)B8) blsa

A8 3950 JUBnl 18155 Sl Juos ¢yl asdlos I w
38 pls 1) PowerPoint 2007 buxs sla (5 595

Sawliddn D 3 Hinles Soalxl Jgual
A ol b Sioles sla Jbalml sla ooy glssl

283 Giules 5 03,5 Jb 03,5 0 a3 1) iules Jolb o
IS o3latl LNl Calize s 7 bl

CPXYY

Y

\

AU 83 5 a3lal 1) Lo 2yMl




% Y—EV/YE/N/E HouisS Slad pa 9 (S i igel Yo jluwd Hlaslianl o Lo

P ol bl 50 PowerPoint 2007 1531 2 5 Microsoft Office 2007 ac gozo sla)l 331 551 )5 S5

iales 4ol 355 wledbl aShl 5 53 320 Sl B 383 (o Loy &3 Ly oSl (ol oY slal sl (yaslsl I 531
0SS 0 il 5o 1 3wl T e 39a g Slidepl & Silxio loawss inles 4ol p yal -3uiS Sl
Sl 0325 6o oslal 5 P8 4 pF )0 4 b Dllae 530bb 0 a5 Jsdae plide uSeolsgeie (yie
Sk 09,5 calixe sla aib) s b ylo x5 PowerPoint 2007 )l ;31 P 03 231G Hinles @ uble
bl o OlT 5 @ s s LT Jl oslaiul Juls yred &5 .l oub

Lo oMl sy DB 5 i 7 bl 3i)le PowerPoint 2007 515381 o 55 sl S5 329 5 L« Jl s
ALl Glles Sl € siio Sl ivs) bl 5 1 581l oslatul wsllbe (5 a5LI sl wledlol glgil I o Mlaiuwl

Microsoft PowerPoint asb s sl yal

oo 3Ll 351l (Sadol jo ) 45 b red b (slaiy 35 Microsoft Office 2007 ac gozo —uas I (w
435 ww 5 All Programs aiy 35 lanl Start sgie JI Microsoft PowerPoint slyal sl .55
Ay 35 D g 50 0393 gio oyl Vo a5 Office acgozmo sladsl 1 auls Gl .aws ol | Microsoft Office

AuiS” wlxasl | Microsoft Office PowerPoint 2007

I_k_! Pt S o]

'n e

3 Tk i s P [T
E S— 0 ¥
= 1mmes e .
‘;:P“" = e Menrge *
] Hetgaerw *
L i I i

W ot By
|_:!:nm'tm.lh-

PowerPoint aoli o 4 355 (1-1JGé)




PowerPoint 2007 1331 53 Joaxoly lisbs T\~

O buzme. 3,5 3ualsd oa8line Su3a Siules ael j w9 (SIB SNl 5 PowerPointael 5 gaub JL L
(\—‘JJLA») wmawl oaubh JaSis alizko (5l wound )l 4ol o

e |l [ PR S—— S
] et | g e
ia"' Lojiamar | e S |
|".'.r—...-.- e R R T T |
[ - um -

Click to add title

Click to add subtitle

] %

iolas dolipw o xmis 2Linl (1-F JGs)

bl (50 020 T &0 0 iy ol sl S0 )0 B yse

MLA.QLQ&G-;»)JMAJb}.‘).n\_d),uu.)}.))ﬁ;k’o)bk’))m UTQQ)AMQ“M|&I&OHL)A_J

D1 08 oT 0. s Jolb 03,550 50 a3 sl




j o Retent Decuments
| iensidownisadd =
'_;f Gipen i EBQIED =
1 setsentation FINAL | KAMEL | P 0.7 =
H S 4 Cepy i@ old -

Office sgio (1-FJGb)

S)ls )13 Quick Access pb a4y S 5510l lgs K Office ans's wawl) wiom)s

Save WS Ul o 4 whgimws 31 ael 53 03 63k) 3, &S sl (S giws Jolids Jlgs oyl
ol (03w 93 Jos 330 [oLz.:l) Repeat 5 (wlloc o) Undo . (o pn3)

@'&.E_"L' Sic) *
— Home | Inset  Page Layout
N o

(Quick Access ) & g piwd g (1-€ JGis)

e ...«raﬁslaqu@

Quick ) & o pdwd Dlublss )3 b S puae py sldess Jl (A uileie Jles g )

SS T AeSS 90 VB pl sl New aess sl caibl (o iwd ) ddued b auas )l 3(Access

DS Dlxsl D 55 S ) g0 4SS (1-0 JSib) oaub Jb (5 gio Sl (s 3w

\ J




et
"'_| Hems l_...;!'_“ Customine Quick Acorv Toolbar

b Cuil
: Open
—J Copy
H:h J Faemid Painl L‘.r_l g
E-rrmsi

Quiick Print

. ' Print Praview
Spelng

(Quick Access) gpw uwpriws A jolilss 9305 uiléw (1-0 JKis)

Dlial )y (Hle b)) s 5 0auh (1AL 9 (s Ay 990 9o s PowerPoint «=Ulsl 5 ol giws

~aobi py mbw V3 i Jlgs Jolze « RibboN .04, 55 50 (Ulss) RIbbON acgoze ¢yl &3 .25 508 50 V13 YK
09,8 Ylibs ySloc 4y A3 b usn wIS 6 LM @L) o BBl 9 aeSs H3gr Sb) W 4wl Ly
- aubl o3l b 9T L B el 0aub (S3ds

i Pregentatanl - Mitrasalt PowerPaint - X
@| Mome | nset  Design  Animstions  SlideShow  Redew  Wiew  Adddns  Acobat w0
Lt'l 4 :I_I.a- 1 ) EE- ibm P @E! ’,; )
J‘ Lol :a "'_‘“l'i_r"'r_ﬁfi;l'h" lill | oy

(Ribbon) ¢rsws ivles () fUwa)

L35 (50 B 0 pue 9 U Dl ges g ¢ (e ( JSib dile (SileMbl Al gl )

Click to add tithe

] inles (1-V JCs)

=P Outline 9 Slide ab) 95 shls 9 AR (5o )|)§ olaal s ) oMl S & ol 9l anb U"I

R




Slide ity j il (1-9 %)

Auilgs 5o Laiis 9 Soub 50 oBline sl )3 Seag0 Sl e kdd Al eyl bl b : Outlineasl,y o

(VA JEb) -3 il e 5 b 4 b LT

o3y Ylis S5 55 o ojlasl Ls Sl JB V>S9 g0 SLAINI ples &b) yl Dbl L - SlideasL) o

%;_.x

daal il

i -

1 ek

® ol il g gl o ATEA IR 0 L0l e s Gl
3 el bt B b Lo s it il g L
i ¥ s i e it Bl B el e P
s SRR § ol gl gl i o e
e | U oo bl ol gk e e k] i s
doolle gy ol s e vt b i B g e P
5K e ol e il Ry M e i i g L
i il P e ey ] R My e
IV I* O ¥ PIFTEL PRI GRS Y | RS, -
A St Bt o 31 et il il A B o8 R i

o e e ol il b gl Lo U LS
i e iy B B i ik s e 0

L TYTpPar T W P R Vg Wy T ¥ |
Bk il

o ] Sl O 68t B el ey 8,0 L 5
L e e B P R T S
i P ok i s bl 5
lﬂ.i..I aly ool Fcis L oy el e Ul el s
el & llad
] —l'l—'-'ld-ﬂ.l-u—--hl-h—.ﬂwukﬁ
LI T ]

B el B ] oty e s Rl s g
ks ey g b Wbl JRRE el e ol el
it ot el

T -

i senl wthas

B e ey Bt el e gl it alh o g phasioh
ﬂﬂ-\dkﬂmﬁmlw Ry i el
P Bl dls oy el A
gt il e g R VS el 8 i

L ..-l-aJp.J..p---IJ-.:-luu dackegr ol amy 0l wl i
iy i ey A

R e L

out line &b sl (1-A JSGis)

. A 3wl oo LT Q

1, View aib ),b.ia O‘ll [CIPERRyty M Axéo b b 9 n o S Slide/ Outline axl u|}.) =P
.S ol Direction a8 Slide/Hide o5 5 )s 9 suws Jlsd




Slide/Outline 4t b b 1-1- JGb

Al (5o wound A Jolis 9 SIS 0 )iy (b VS b9l g

Db (50 031 inled L3Nl slass 5 ol oMl (5 o pledds 3o (Sledol i wiows > )
SIS S99 oMl \6L°5)..n_+_§.'n_sl).; Ol aws lgs bouwg ps .Y

ol 0aub 0als )18 auwl L,glaif))._\).u_._a_:b'gsb.yagmgsl.m wolMe)lgs ) wowps Y

BeieDE P b M

(Statuse bar) uss s ilsi (1-11 JGi)

o ((stinles asl j3 02idd ASDI osub) (6 e 9wl ad )5 )l oMl o 3y ) 0 Lads o )iy oyl
..&mg,.i..s).fxlgGg,;o'}30|}i.c¢_)|)k>1ﬁs|é.)b_.\,$\5|).gﬁplj b Ailes

e
Click to add notes

[ ]

( Note Page ) wublssl o =i (1-1F G5)

.;yhuoaalaéyb,sdaU),b@VJmé);bj)ﬁﬂl




Lo 133l 35 00T Y Sl w354 o Slmil I inles 4ol s 3 PowerPoint 2007 asls 1 (slyal b

Jloslawl b 9 (S Siules awl jo Jl oslatwl ades Jlcagjlun 3oan Siinles ol o by x4 3uilss 5o
LT 1 53k) 3lass Lol 35gib (50 0033 ,3suels (53, V3l 5 s plia )3 Sl pl Jl o s8I S
bl (5o e piws JoB Online =) gu0 4

Fbly 5o ) b & 303 lales Aol K il by

S SUsOffice ans's 590 0 -\

S bl ) New agy 35 -¥

)90 aF 38 ol ) 393 Job slmyl alicke sl b soSwiles 50 New presentation o jgys-Y
sl o glate @laS pa oslatuwl

Ingtalled Tenplate
Instalied Themes
My templates...

v From exigting.,
Miicrosof Office Online
Featured

Apenday

ayeard certdicates
Calendars

Comtinl gladii
Diesigm slides
DCriagrams

Puang

Prerentations
Retsumes

Lchedules

Mare categories

KB Sl ilizko sl Lo (-] FGE)

Dl i)l W Gbs) ol glesl 3l s
Db 5o Sl S Sdules 4o, S : Blank and recent .\




)|

PowerPoint 2007 1531 o Jouxo b LT :Jsl Juad ’ %

DS

= Sl PowerPoint s ssa g0 sla oSl I oslaiuwl b suaa Siules 4ol y; : Installed template

- gy

Do 50 Sl 9 50 Bl S bl o 3335 Sdules 4ol . : Installed themes

Soib 50 Sl (al Al Gl Sl 9B sa aS o8l Gull 0 3uan Sdules 4ol . My template
Doub 50 Sl (gl 03 55 0 a3 Mid aF les (ulwl j 33 Sidules aeb » : New from existing

v O =

8l 9 Nke ol )3 393 90 (5la s8Il oslaiwl b S Sinles 4ol 5o Microsoft office online

Do 50 Sl

-\ ;] P >
Installed themes 5 Installed Template . Blank and recent o5 Jl 55 a3 Sdules s aSDI aws
A sl

=Y

iy hamgini

Vot bom anbng

Frafard
[re

e

lass B 3w 0ua3 b 9T 3L Ledbe oT JAls ) wledbl gals )3 5 3uan iinles asl o K Slxl Jl asy
4, PowerPoint sl oauiis o a3 jsin a5 3l ) Sl i 3u0d o ilo) oS eslaiwl 9T Jl aulsns
Sl 0,083 L) s a5 328 e sl Less

CPYEN pae
S5l 5 038

4ol o &

038 0 a3l ] ; :
[ | il J [Cancel

ot 0 s 3 I b ol iy ol N1~ 10 )




Gl 0 un3 (6la we 8.3 5ub auie T P pizmed 5 Jold (i35 VIS Jmo b 035 o plia )
D3 gubs 50 0 a3 PPIXe p8 L Ly b (6 58 i ob & s dhiwe s glaie PowerPoint )s

o33 2003 15 20005l asuws s aid I & 6la woyd b Dagh sla inles Sulss 50 14355 é
Ry

SuiShHal b ) Jalre (Sinles 4ol jo 5 0433 sl o
Auis s Office anSs 590 0 -\
A ol Save a5 -Y

U5 ol pled &3 1) kel SaVE plo s « b b 0 0 33 ols el b M ()l Juls 5124055 é

..)}.ﬂ:u.oi)'l._»saveASkso):_:bv)o.))fo){;.')

D Jold o und Gl s )0 Abisy 9 sabbs J=e Save in Lals Jolae Save Asoc iy 9aubib Jl Gue-Y
A8 bl

S 9o File name «ouwd »s 2l 45.5):).53).) RPN inles Job6 sl a5y '_,AU—E

S @i 1) 93 )8 0 d Sl b5 350 a6 Save as type  Jolis )s -0
LS SIS savedaeSs ) po -7




Sap | e eno e @xoa-

||
g bss sl Jmo

Save As o =i (1- 15 J5G)

Y owes D

s M s Omid PL & ¢ 303 55 Slul Jud oy 505 )3 &5 ) Blank and recent g o3 Jl Sinles s asl)l
S48 o ja 3 MyDocument

Samrr | (L] Py Cocurerts * B-3 ¥ ad-
|l¢mrn-u-: atalorky
Lo ook Lesrkaads
" 1 Dita St
ks
Har Mg
h Dxxsranis f Pt
il oo
g | ke hensbocks
oiliedster

(1- 1Y J5s)




Aol po £ 035 Sl wde 38 b D 0T eobss Suilsi 0L 0T i 5 ules aebp 035 0 a3 Sl o

bl Jo OT Ginles b 5 Gl yg Ailgs e Situles

DS Al ) Jalre inles 4ol o o 03 ,55b sl m

LSS SIS 1) office awSs-\

LSS olxsl ) open a8 osus ol (s gie J-Y

SaiS Gasuiie 1) b33 ) g0 Jobd adigs 5 sl cLooK iN Lol Jolae 5 Open o y=iy o5 -¥
iS5 1) OPEN aeS's uawy 03,5 bl b 433350 Jold osub 03y inles sla Jold ) JI €

s | L= i s, 8 - R B SR b
[y o | NN
[ pasace
(5
gh
QL“

ST e &

Coen 9 [ own ]

ulos doli o I ML o pzis (1- 1A JCs)

=Y 2ped @

SuS Ol 39395 03,5 o und My Document wow 18 s as ) Omid (s sl




tnckgs (L) My Docments B e @ %o

] ]
LT T ————————— ,,_l
(e (ETK) TR

Open (sl ogl=o o3l (1-19 JC5)

(Layout) asMwl olodua V-0

Slodun .21 Hinles ) 393 wleMbl 9 39 5luy Sinles asl j3 K 4 323 50 ol PowerPoint )l 3l F3%
DS oo e 1) SSBLT uolic 5 ¢yie wwlgie § 8 IS Jxe 3uiS oo walsil SoMuwl sl a8

bl BT sal b s e Jobibs 3iles (50 LI pl &5 SIS 395 VI alass (oMl plodus 2 s
Dbl SS8DS £ 5 9 e 035 35 ju0d plo jed Vsl Ay Jislgs (503 LI yal (s

Dol (50 5w 2 LMW Hleaun glgil anlsl Hs

bas J5 5 (Section Header)la Juos jun 35Muwl (Title Slide) olsic oMl Jold 6l plosus

L 503,85 3)ls b pdas 3)ge e Suilss (5o Ladbe GBS JI )0 90 SulS b .aubl e (Title only)ulsic

S8 il

ol Sales ol j wlsie Jols boss : (Title Only) ylgic boid 3wl

Vlgie )3 VYgose . 3ubl (50 (53 wlsic 9 Sules Aol e plsic Jols : (Title Slide) ylgic 3oVl o
bl 5o dnli 2 A1 Ole by 9 S b S b ibgles doli ps 0308 Al el e 50

(Section Header) b Jsod yus 39wl




(= tayout o | B e ||
Flow

i,

Title Slide Title and Content | Section Header

SIS ploass loil (1-F - JGs)

£hial 5 )ls ey sl el Jolis (ol oi oM &S wuwl Layout 4 555 5008 s woledua &5 oyl
oals ) 2 S + Ulgie 05 YOUL (32033 208 3 ol £95 (2

.\.mbup)»(rahs PSS Dl ges (J9an  pyguas disle) 8IS
aéb 23 3385 DS Slules ael o 03 (sogasy wledbl 3yiles 5o alike Sla Yleduy bl b Lok

AU (5o s D 30wl )3 39 g0 Sla S Slass oMl pledas

23S Dall ) Jalre oMl (Layout) plesus ¢yuss sl n
L B & bgs yo s IE .08 S Layout aiy 35 ) Slide 05,5 )5 5 3uis Sl Home asl) 50 2 -\

Do 50 03l Hlules
DS Ol D sed HB5 )90 B Y

@uuuu
haut Design _ nimuions  SideShow  Review

A'.'.ut 'E_"_,, Rapout "4 = - Ry
=4 Co el
Paste i Hew
= J Forme Painder || siige~
. 5|

ol Layout _yisles (1-F1 5s)

S Sl b 398 wlelol 5 3uiS OIS abo gy yo VI (59 0 palb J..;.)Lml)so,.ifl[am—\"




g

Click to add subtitle

ob bzl Layout s wleMbl 3909 (1- PP GE)

5938 b alb 6l Al s acgeze @ly 3 . sl Al &I S K 5 02idS Juis paie
SIS 5o oS I a3l o ) gliie

Slass & lgs 5o Laids .38 5o Slml S 3uMwl 5 PowerPoint (idules aol jo S slxl P s
)1 SNy Loubs (utislas 4wl p 54050 & oMl Slass . auiS aslal 393 oMl el g=ds

S Jae pe) o) & dua Sl 03,5 a8LSl sl

.. S S Home asb) 550 -\

lj S S5 New Slide aiy 35 b aess 50 Slide o3 ,5 ) -Y

b o Sl b bl Gloun AT b dusa abol A Gl | aass 55 S

DS Olil D soa ks S)ge B -Y

Sl (50 A8LAI Loubs (Siules Jold an S0 oMl -€

7 D
Go Oy ER e (5o skl s Al K Slide/Outline aab ) Enter sls s L 14353 é

38 oslail 3uaa 3uMl 9355 a8Lsl (sl Ctri+M us )5 3uls Sl lgs
. Y,

( Vo D

A8 aslsl Omid s &)l & (JJB) Blank pleaua b sasaa .;g)lmL




@

Ilhl-rI_H_.ll [ R L T -

e
s Togn

A i ot e B T - i b
e ] e ,ﬂ,é'ﬁ,ﬂe_‘:ﬂ. Lgﬁ el T S

V't s | || B e el [ e e § 5 ot tn it~ || 9 ) e g T Wit | o ek

Lesesd L o Th

L ol Dy :

——

(1-F¥sis)

A 33 3l LT & aliial a5 1) Lagtll Sl ibss « el 039 Lol
P Jag p2) Gbo) & el B3 (sl

2 S5 Home aslj s, -1

- Delete . sus Ll 1) Delete Slide aiy 35 Slides o35 )a-Y
Dol (30 B 0duh Dbl 3oMwl -V

e A\
S 5o B3a D 5l 30wl 5wl axao s Delete auls : 4SS é

. Y
7 N
10 oet

L LSS B3 D =Y g0 )05 S oub aslal Jo)‘.mb




tomp | A D deemsbesr  rlms Reww e - |

o T S T
J‘_!— 1- ad e R N 4 "--.-'""ii-:-':' drmact 1g tmprren 500 ¥ _"“'.' = e ivim T
foptamd e e

i g

Barrn B b v ey
RIS

ols oMl lssl

oMl il (1- PEJGi)

Sl Ogile IS 9 yslgd Jgsol (plwlish 1-A

Microsoft Office Button (B_i\'replaces the File menu and is located in the upper-left

corner of these Microsoft Office programs.

When you click the Microsoft Office Button @\ you see the same basic

commands available in earlier releases of Microsoft Office to open, save, and print

your file.

Test:

1- Microsoft Office Button replaces the .......... Menu.
a) Edit

b) File
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Customize a background style for your presentation

1- Click the slide or slides that you want to add a background style to. To select multiple slides,
click the first slide, and then press and hold CTRL while you click the other slides.

2- On the Design tab, in the Background group, click the arrow next to Background Styles.

3- Click Format Background, and then choose the options that you want.
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Fonts =

1 Hi :
| @ Effects - Hide Background Graphics
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Background IFi
Figure 2-15
Test:
1. To select multiple slides, click the first slide, and then press and hold ...... while you click

the other slides.

a. Background

b. CTRL

c. Page Setup

d. Background and Page Setup

2. On the Design tab, in the ..... group, click the arrow next to Background Styles.
a. Background
b. Theme
c. Page Setup
d. Background and Page Setup

3. Onthe ..... tab, click the arrow next to Background Styles.
a. Design
b. Home
c. Insert

d. View
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Display Pictures In A Photo Album

You Can Quickly Creat A Photo Album Presentation To Display Images Or Graphics In A
Variety Of Styles. The Photo Album Tool Saves Time Because It Allows You To Insert Many
Images At Once And Then Formats The Slides With The Selected Number Of Pictures.

The Images You Choose Can Be In Any File Format Power Point Supports, And It Is Not
Necessary For The Files To Be Located In The Same Directory.

Test:

1- Photo Album Display...............
A) Number Of Picture

B) Text

C) Chart

D) Images

2-Photo Album Tool Allow You Insert Many Images...............
A) At Once

B) One Time

C) Two Times

D) Never

3- Which Images You Can Choose?

A) Any Image

B) JPG Image

C) Any File Format Power Point Supports
D) Graphic Files
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You can change the look of all of the slides in your presentation when you create a new slide
master.
Slide master are templates that define how slide are formatted. Slide master also allow you to
insert common elements on every slide, such as slide number, the date, footer text, or even
logos or pictures. If you want all of the slides in your presentation to use similar fonts
formatting, and graphics, slide masters are the best way to do this.

1o Are Templates That Define How Slides Are Formatted.

A) Slide Master

B) Slide Show

C) Slide Sorter

D) Slide View

2- When You Create A New Slide Master You Can ............ The Look Of All Of The Slides.
A) Delete

B) Convert

C) Draw

D) Change

3- Slide Master Are The Best Way To Use ......... Fonts, Formatting And Graphics.
A) Different

B) Similar

C) Very

D) Several
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To Play Your Video Clip

You can add a button to you slide. That, when clicked, plays a video clip in windows media player.
The button you create is an action button. In this case, the action is to play a specific video file using

windows media player. To launch the video clip, You must know the path to the file.

Test:

1- Where Your Video Clip Plays When You Clicked?
A) In Slide

B) In Windows Media Player

C) In Power Point

D) Video Player

2- The Button You Create Is ........... Button.

A) An Action

B) Video

C) File

D) Play

3- What Do You Must Know, To Launch The Video Clip?
A) Button




B) Specific Video
C) Path To The File
D) Windows Media Player
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all slides during agiven time period.
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Use Comments To

ADD NOTES

You can use comments as a way to communicate with reviewers or insert a reminder into a
slide. Comments are like electronic sticky notes that you can use to type any text you want.
Comments can be great way to communicate with a presentations author without changing the
presentation ltself.

Test:

1- Why You Insert Comments Into A Slide?
A) Review

B) Spelling

C) Type Text

D) Change Presentation

2- Comments Are Like ................. Notes That You Can Use To Type Any Text.
A) Changing

B) Electronic

C) Slide

D) Type

3- With Comments You Can .................
A) Change Presentation

B) Delete Presentation

C) Communicate With Presentations Author
D) Type Text
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